
TESSY Application Notes   

TESSY Application Note #020, 30 May 2023  Page 1 of 20 

Razorcat Development GmbH 

Witzlebenplatz 4   14057 Berlin    Tel. +49 (0) 30 - 536 357 - 0    Fax +49 (0) 30 - 536 357 – 60 

support@razorcat.com 

Keil µVision Debugger 

Abstract 

This document describes the usage of the Keil/ARM µVision Debugger as target 
system. What you need is a project file with the correct settings for your target 
hardware (or simulator). Such a µVision project file needs to be adapted for usage 
with TESSY as described in this document. 

 

Please note:  

1) The communication between TESSY and µVision uses different communication 
interfaces depending on the µVision version. Please refer to chapter 1 of this 
document for details. 

2) There is a new TEE attribute CMSIS Version which regards the version of the 
installed compiler. Please refer to chapter 5.1 of this document for details. 

3) Since TESSY version 4.3.10 the tthd is used to start the µVision Debugger before 
the test run and it is used to close the debugger after all tests are executed. Refer to 
chapter 4 for further details. 

4) For microcontrollers like EFM8BB3 from Silicon Labs it may be required to set TEE 
attribute Send Single Bytes to true. That is, writing data in blocks is not supported 
by the debugger API for this microcontroller. Enabling this attribute may result in 
slower running tests. 
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1 Keil/ARM µVision Interfaces 

The communication between TESSY and µVision4 or higher uses the UVSC 
interface of µVision. This interface allows remote controlling of µVision for test 
execution. 

Former legacy versions of µVision (version 3 and 2) used two different interfaces 
depending on the specific version. The table below shows the applicable versions 
and the kind of interface used. Both interfaces are part of the respective Keil/ARM 
µVision installation. 

 

Controller µVision Version Description 

C166/C51 3.62 and higher UVSC interface 

ARM 3.80 and higher UVSC interface 

ARM/C166/XC166/C51 4 UVSC interface 

ARM/C166/XC166/C51 5 UVSC interface 

 

µVision 3.80 and later provide stable versions of the UVSC DLL. Prior versions (3.51 
to 3.61 for all microcontrollers and 3.51 to 3.80 for ARM controller) are no longer 
supported. Please, utilize TESSY 4.3 in case you need one of these obsolete 
versions. 

 

Important note: The UVSC interface requires the communication port number within 
µVision, i.e. UVSOCK (TCP/IP) Settings, to be enabled as described in chapter 2.1. 

2 Setup for µVision 

The UVSC interface requires setting a port number which is available at different 
locations within the µVision GUI (depending on the version). You may choose a 
different port number than the default one, but this requires also changing the Port 
attribute within the TESSY Environment Editor (TEE) as shown below. 

 

Please note:  

Please make sure that the port number selected for TEE attribute Port corresponds 
to the port number you have selected within µVision. 
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2.1 µVision4 or higher 

Since version 4 µVision uses the UVSC interface which has to be activated by 
enabling the port number which is used to connect to the µVision UVSC interface. 
Choose Configuration… from the Edit menu to open the Configuration dialog and 
choose the Other tab. 

 



TESSY Application Notes   

TESSY Application Note #020, 30 May 2023  Page 5 of 20 

Razorcat Development GmbH 

Witzlebenplatz 4   14057 Berlin    Tel. +49 (0) 30 - 536 357 - 0    Fax +49 (0) 30 - 536 357 – 60 

support@razorcat.com 

 

 

The default port number to be used with TESSY is 4823. Please make sure that the 
Enabled toggle button is checked. 

2.2 µVision Legacy Versions 3.xx 

µVision version 3.62 and later started to use the UVSC interface, within which you 
need to setup the port number used to connect to the old µVision interface as 
described in chapter 2. Choose Configure Socket Port Number from the Tools 
menu as shown below: 

 



TESSY Application Notes   

TESSY Application Note #020, 30 May 2023  Page 6 of 20 

Razorcat Development GmbH 

Witzlebenplatz 4   14057 Berlin    Tel. +49 (0) 30 - 536 357 - 0    Fax +49 (0) 30 - 536 357 – 60 

support@razorcat.com 

This will launch the Configure Socket Port dialog as shown below. 

 

 

 

The default port number to be used with TESSY is the 4823 whereas the default port 
number of µVision version 3 is the 5105. You may either change the port number 
within µVision or adapt the TEE attribute Port as shown in chapter 2. 

3 µVision Project File Preparation 

In order to run any test, you need to start µVision with a µVision project file that has 
been prepared as described below. We suggest using the project file that you are 
using for your development project. You may as well start with any other µVision 
project file (e.g. we use the “Blinky” from the examples projects provided by µVision’s 
Pack Installer). 

3.1 µVision Target Settings 

µVision manages so called Targets within a µVision project file in order to handle 
multiple configurations within the same project file. The targets are displayed within a 
combo box within the µVision toolbar. It is recommended to add a new target for use 
with TESSY. Please follow the steps below to create and configure such a target. 

3.1.1 Step 1: Select µVision Project 

Start µVision and open any of the “Blinky” projects copied from µVision’s Pack 
Installer. The open combo box as shown in the screenshot below contains the 
available µVision target configurations. 
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Select the target configuration that you would like to use for running tests with 
TESSY (e.g. “Simulator”). 

 

Please note: You may as well use any other of the available target configurations. 
But make sure that the selected configuration runs fine with the simulator target or 
your connected hardware. 

 

3.1.2 Step 2: Create a Project Target 

Select the Project Items… entry of the Manage sub menu of the Project menu. 

 

 

This will show the Manage Project Items dialog. 
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Within this dialog, you need to create a new entry derived from the currently selected 
entry. We will use the Simulator configuration as an example. Add a new entry to the 
Project Targets list by pressing the New (Insert) button. You may choose an 
arbitrary name for the new entry (e.g. “TESSY Simulator”). 

Please note: A new project target will be copied from the project target that is 
currently selected within the µVision main window (refer to section 3.1.1) 

 

 

 

Press OK to save your new configuration. 

3.1.3 Step 3: Adjust the Name/Folder of the Executable 

The newly created project target needs to be configured for TESSY. Please select 
the new project target “TESSY Simulator” within the project targets combo box of 
µVision as shown below. 
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Now choose Options for Target ‘TESSY Simulator’… from the Project menu. 

 

 

 

This will display the Options for Target ‘TESSY Simulator’ dialog. After switching to 
the Output tab, you will see the name and path of the “Blinky” executable. 
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The following changes are required within this dialog. 

- (1) Press the Select Folder for Objects... button and choose the path to 
the TESSY testarea directory (normally C:\tessy\testarea). 

- (2) Add the name ts_slave.axf into the Name of Executable text box. 

 

 

 

The resulting name of the executable file should be 

C:\tessy\testarea\ts_slave.axf 

 

Now close the dialog by pressing the OK button. The new µVision project target is 
now prepared for your TESSY test runs. 

3.2 µVision Configuration Settings 

To avoid warning dialogs during test execution, you should ensure the following 
configuration settings of µVision. Select the Configuration ... menu entry from the 
Edit menu. 
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Within the Configuration dialog, select the red marked Automatic reload of 
externally modified files option as shown below. 
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3.3 Flashing the Executable File 

Depending on the µVision version and the applicable µVision interface, the procedure 
for flashing the test driver application differs. 

If you have built your test driver for execution using flash memory, you need to 
enable the Use UVSC Flash attribute within TEE. 

 

 

 

If this attribute is set to true, the test driver application will be flashed automatically 
upon start of the test execution. Please make sure that the µVision project you are 
using contains all relevant settings for flashing (i.e. flashing should work when 
triggered manually from within your µVision project). 

4 Start the µVision Debugger for a test run manually 

Since TESSY version 4.3.10 the tthd is used to start the µVision Debugger before the 
test run and it is used to close the debugger after all tests are executed. If you prefer 
or if you need to start the µVision Debugger manually and let TESSY connect to it, 
then you will have to remove the contents of the TEE attributes Slave Call and Post 
Execution Command. 

5 Example: Preparing TESSY for an ARM Microcontroller 

Generally, TESSY provides a default configuration for each compiler/target 
combination. In case of ARM there is a configuration for STM32F10x available within 
the TESSY installation directory. This configuration was adapted from the µVision 
example project “Blinky” copied from the Keil Pack Installer. 

If you are using another ARM microcontroller, you need to follow the steps below to 
create your specific configuration. 

5.1 Adjust TEE attribute CMSIS Path 

Browse to the path of your Keil ARM installation folder to look up the currently used 
library version and adjust the corresponding TEE attribute CMSIS Path. 
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5.2 Step 1: Select a µVision Project 

Choose a suitable µVision project file that contains all the necessary settings for your 
microcontroller. This may either be the project file that you are already using for 
development, or one of the Keil/ARM example projects from the Pack Installer or you 
may create a new project from scratch. 

After successfully building the project within µVision, the following files should be 
available. 
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The easiest way is now to find the objects of these files in your µVision project folder 
and copy them into a separate folder within your TESSY project folder. Eventually, let 
TEE attribute InitObjDir point to it and keep TEE attribute InitSrcDir empty. 

 

5.3 Step 2: Create a new TESSY Project 

Please consult chapter 3.1 TEE: Creating databases and working with the file system 
from TESSY’s user manual if you have not done by now. 

 

Please note: Make sure that the project was built by µVision before proceeding. 
Some of the files required for TESSY (e.g. the scatter file) will be generated during 
the µVision build process. 
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5.4  Step 3: TEE Configuration 

Please consult chapter 6.5 TEE: Configuring the test environment from TESSY’s 
user manual if you have not done by now. 

As described in step 1 (see 5.2) you can either use the object files or set the 
attributes Startup File respectively System File. 

Change the default configuration settings in order to reference the Scatter File 
attribute to the file created within step 1. We suggest that those attributes reference 
files from within the $(PROJECTROOT) directory. 

 

5.5 Step 4: Edit the Makefile Template 

When using another microcontroller than the Cortex M3, you might need to adjust the 
makefile template. In this case, copy the makefile template from the TESSY 
installation folder (the most current file is the one with “uvsc” in its name) 

…\sys\templates\make\ts_make_uvision_uvsc_arm_v5.tpl 

into your project folder 

$(PROJECTROOT)\config\ts_make_uvision_uvsc_arm_v5.tpl 

Now open the TEE again and change the Makefile Template attribute accordingly 
(i.e. choose Edit Attribute Value from the context menu): 

 

Open the makefile template within an editor and check compiler and linker settings. 
Variable S_COMP_OPTIONS contains the compiler settings. You must not remove 
the “TS_” defines because they are needed to build the proper TESSY 
communication modules. Variable S_LINK_OPTIONS contains the linker settings. 
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The respective settings can be found within the µVision project that we created within 
step 1 (Refer to chapter 5.2). Open the Options for Target ‘TESSY Simulator’ 
dialog and switch to the C/C++ tab. 

 

 

 

Within the Compiler control string you will find the --cpu option. Adjust the value 
within TEE accordingly. 
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All relevant configuration settings are now available within the config directory of 
your project. 

6 Troubleshooting 

6.1 Error Executing the Test 

If TESSY fails to execute the test, please check the following: 

- make sure that µVision is running and the correct Project Target is 
selected within µVision as described in the previous chapters 

- check the Output settings for the currently selected µVision project target 
(default is c:\tessy\testarea for the path and ts_slave.hex (latest 

versions of TESSY use .axf instead of .hex as file extension) for the 

executable) (see 3.1.3) 

In order to check your settings, you may press the Debug button within µVision to 
enter the debug mode. 

 

This will load the executable test driver into the debugger. If everything is correct, the 
debugger should stop the target application at the main function of the TESSY test 
driver as shown below. 
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If the Output setting of the currently selected Project Target is wrong, µVision4 and 
µVision5 will show the following dialog when trying to enter into debug mode: 

 

 

When working with µVision3 you will see something like the following message within 
the µVision message window: 

 

6.2 HEAP Space Setting for C++ 

If you are executing a C++ test object and the test driver binary fails to start 
executing properly (i.e. does not reach function main() when started manually) you 

may need to adjust the HEAP space (this is zero by default). This setting is provided 
within the startup code (e.g. STM32F10x.s). You may either edit the file directly or 
use the Configuration Wizard from within µVision to change the settings. 
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The default value within the STM32F10x.s startup code file delivered with TESSY is 
0x1000. 

 

Please note: Other startup code files will have different options within the 
Configuration Wizard. 

6.3 Warning after Starting a Test 

The following warning message may be displayed when repeatedly running tests with 
µVision: 

 

This warning is caused by TESSY when trying to delete all files within the testarea 
directory as preparation for the next test run. If a test with µVision has been run 
before, µVision still has an open file descriptor on this temporary file. 

 This warning can be ignored. 

6.4 Removing Breakpoints 

When running a TESSY test non-interactively, i.e. without the Define Breakpoint 
feature selected, TESSY will normally delete all breakpoints within the µVision project 
before starting the actual test. 

If this fails, there may be invalid breakpoints left from previous test runs or debugging 
sessions. In this case select the Kill All Breakpoints menu entry from the Debug 
menu before starting the test with TESSY. 
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6.5 The debugger IDE window vanishes 

By default, the μVision debugger window will be hidden unless the test was started 
with Define Breakpoint at Test Object or logging is enabled. The IDE’s window will 
vanish from the taskbar. The μVision window can be restored by typing ALT+TAB 
and selecting μVision. If the debugger window should always be visible set TEE 
attribute Hide IDE to false. 


